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  GETTING STARTED 

Do not EVER use two instances of the robot, or any combination of robots 

with identical magic numbers on a same account!!! 

If you decide to trade on more currency pairs at the same time, you may consider 

reducing the risk for each pair (using AutoMM=1-2% for example).  

 
Before installing Volatility Factor 2.0 Pro on your computer and commencing trading on a real account, 

please read this carefully: it may be crucial for your future profits. 

Trading forex entails risk and each instance of negligence or inattention may lead to significant loss! 

1. We strongly recommend that you operate a demo account before trading with real money. This will help 

you become familiar with the way Volatility Factor 2.0 Pro operates before you commit genuine funds to a 

real money account. 

2. Please be exceptionally careful when determining trading volumes and setting automatic risk management 

parameters! 

3. If you suspect that Volatility Factor 2.0 Pro might be operating incorrectly, please halt operations and 

contact us immediately! 

 

WHAT YOU SHOULD KNOW BEFORE USING 
VOLATILITY FACTOR 2.0 PRO 

 

 Supported currency pairs: EURUSD, GBPUSD, USDJPY and USDCHF. 

 Volatility Factor 2.0 Pro is compatible with all MetaTrader 4 brokers, as well as with brokers using ECN-

type order fulfilment. You do not need to change any settings. 

 Volatility Factor 2.0 Pro automatically recognises whether your broker offers four or five-digit quotes. 

You do not need to change any settings. You do not need to multiply TakeProfit and StopLoss values by 10 

if your broker offers five-digit quotes. 

 We do not recommend that you launch and close your trading terminal too often. Ideally, it should work 

without interruption from market opening on Monday to closure on Friday. 

 For problem-free operation, use a computer with a minimum configuration: 1.5 GHz processor, 1 GB RAM, 

and Windows XP, Windows Vista, or Windows 7 operating system. 
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 Maintaining a stable internet connection is of the essence to ensure reliable Volatility Factor 2.0 Pro 

operation. 

 It is the spreads offered by your broker that chiefly determine how much profit you can make by using 

Volatility Factor 2.0 Pro. The recommended spread for EURUSD is under 1.5 pips, for GBPUSD under 2 

pips, USDCHF under 2 pips and for USDJPY under 1.5 pips.  

 Be on the lookout for brokers who steal pips and who try to fulfil each order at a price which is less 

favourable to you by 1 or 2 pips. This way, advertised 1 pip narrow spreads can easily work out at 3 or 5 

pips, thus reducing profits made by Volatility Factor 2.0 Pro. Be particularly cautious of new brokers 

who advertise aggressively on the internet. 

 

The MetaTrader4 (MT4) Trading Platform 

Volatility Factor 2.0 Pro operates within the MetaTrader4 trading platform. MT4 is a free trading platform 
available through most forex brokers. 
 
If you do not have MT4 installed on your computer, you can download a copy by going to any brokers and 
requesting a demo account:  
 
We can’t stress enough, how important is to choose a decent, reputable FOREX broker with competitive 
spreads and good trading conditions. If you are new to FOREX trading, make sure that you spend enough 
time in your own research for that matter, before investing any real money in any FOREX broker! 
 

 

Installing MetaTrader 4 
 

Browse through this section if you are familiar with MT4 and already have a broker account. 
 

 
 

 

After completing installation, you will be asked to create a demo account. Fill in the details and select the 
amount of the account deposit. Enable Agree to subscribe to your newsletters, then click Next. 
 



 

 
 

- 5 - 

 

 
 
 
 
 

The program will ask you to select the trade server to which it should connect. Click Next. In the next window, 
click Finish. 
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Your demo account is opened. Close MT4 so that you can install Volatility Factor 2.0 Pro. 

 

 

INSTALLING VOLATILITY FACTOR 2.0 PRO 

 

We offer you two ways of installing our software: 

Automatic installation using VolatilityFactor_2.0_Pro.exe 

 After logging into the member zone with the username and password provided, download 

"VolatilityFactor_2.0_Pro_Installer.exe" from your personal download page to a convenient location on 

your computer. 

Install Volatility Factor 2.0 Pro. During installation, select the installation folder of your MetaTrader4 

terminal. This folder would usually have the name of y  

 our broker and would be found in C:\Program Files 
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Installation by Copying 

1. After logging into the member zone with the username and password provided, download 

“VolatilityFactor_2.0_Pro.ex4”, the “VolatilityFactor_2.0.dll” and the “vf2logo.bmp” files from your 

personal download page to a convenient location on your computer. 

2. Identify your "Application Data" folder. 

First you need to locate your Application Data folder of the MT4. To do this, go to the File menu in the MT4 

platform and click on "Open Data Folder" (check out the image below). 

 

 

3. Place your robot files in the right location. 

First thing to do is to open the MQL4 folder, which is in the "Application Data" folder (which you already see). 

The next steps are very easy: 

 Place the "VolatilityFactor_2.0_Pro.ex4" file in the "Experts" folder inside the "MQL4" folder. 

 Place the "VolatilityFactor_2.0.dll" file in the "Libraries" folder inside the "MQL4" folder. 

 Place the “vf2logo.bmp” file in the “Images” folder inside the "MQL4" 
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4. Run the Volatility Factor 2.0 Pro. 

After you have successfully placed the files in the correct folder, all you need to do is to restart your MT4. If 

you have done everything correct, the EAs should appear in the "Navigator" Tab of your MT4. 
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ACTIVATING VOLATILITY FACTOR 2.0 PRO 
 
 

You should activate your copy of Volatility Factor 2.0 Pro for your demo and real accounts through our 
website. Login to our member zone and then find the account activation page. Type your account number 
into the input field and click Activate. Repeat this procedure for each account. You need to activate the 
demo accounts in the field for demo account activation, and the real money account in the real money 
account activation field. 
 

Your Volatility Factor 2.0 Pro licence is valid for an unlimited number of demo accounts and for one real 
money account. The licence is not tied to one computer. You are free to trade using your accounts on any 
computer at home, in the office, or VPS. 
 
As well, you have an option to remove an account that you do not use and activate a new account on its 
place. 

 

You should activate your demo or real account even if you wish to backtest Volatility Factor 2.0 Pro.  
 

Your online authentication procedure may take some time. If you see an “Online Authentication 
Problem!” alert, wait a couple of minutes and try again. If the problem persists, contact us at: 

support@volatilityfactor2.com 

 
 

 
 
 

 

 

 

 

mailto:support@volatilityfactor2.com
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STARTING AND CONFIGURING 

VOLATILITY FACTOR 2.0 PRO 

 

After installing and activating Volatility Factor 2.0 Pro, launch your MT4 terminal and click Tools->Options. 

 

At this stage, make certain that you have checked and unchecked all the boxes exactly as shown below in 

order to ensure correct Volatility Factor 2.0 Pro operation. 
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Now, open the graphs for the currency pairs you wish to trade, then select the 15-minute graph, М15. 

For a comprehensive information regarding the latest recommended and supported currency pairs and for the alternative 

settings, please contact us. 

 

Select the 15-minute graph, М15. 
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Now you are ready to place Volatility Factor 2.0 Pro on the chart. In the Navigator window, double click 

Expert Advisors to expand it. You should now see all Expert Advisors including Volatility Factor 2.0 Pro. Now, 

you can right click Volatility Factor 2.0 Pro and select Attach to a Chart, or alternatively simply drag 

Volatility Factor 2.0 Pro onto the chart. 

 

After placing Volatility Factor 2.0 Pro on the chart, you should see a smiley face in the upper right hand 
corner of your chart. This means the robot is running. If you do not see a smiley face, make certain that under 
Properties on the menu bar, the Allow Live Trading box is checked. If it is checked and you still do not see a 
smiley face, go to Tools on the menu bar and select Options. A popup will appear. Select the Expert Advisors 
Tab and check both the Enable Expert Advisors box and the Allow Live Trading box.  
 
 
 

You can enable or disable Volatility Factor 2.0 Pro from the Expert Advisor button at any time. 
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VOLATILITY FACTOR 2.0 SETTINGS 
You can edit Volatility Factor settings by right-clicking anywhere on the chart and selecting Expert Advisors -> 

Properties. 

IMPORTANT: Volatility Factor 2.0 Pro have a regular and a Simple version (two .ex4 files). These versions are 

almost the same - they use the same trading logic. The only difference is that the simple version has fewer 

parameters to ease some customers. We strongly recommend to use only one of these versions - either the 

Simple, or the regular one. Do NOT attach both the versions in one account! 

WinLargeFonts true/false: use "true" to adjust the robot information box display in case you are using the 

Windows Large Fonts. 

 

Magic: An unique identifier through which Volatility Factor recognizes and 
manages its own positions. If you use other expert advisors on the same account, 
please ensure that each of them has a distinct unique identifier. 
 
EA_Comment: You can type a comment here if you wish to mark the Volatility Factor trades. 
 
Signal_1 true/false: Activates the trading signal, which is generated in the direction of the current market 
impulse. 
 
Signal_2 true/false: Activates the trading signal, which is generated against the current market impulse. This 
signal is generated only in specific hours and this is the only strategy which is affected by the GMT_Offset and 
the DST_Usage parameters. If you do not want to use this signal you should not worry about the GMT_Offset 
and the DST_Usage parameters. 
 
MaxSPREAD: Maximum allowed spread in standard (4 digits) pips. We recommend MaxSpread=2.5 for 
GBPUSD and MaxSpread=1.5 for EURUSD.   
 
Slippage: Maximum allowed slippage in standard (4 digits) pips. 
 
NFA true/false: Use “true” if your broker is NFA regulated, or if you do not want 

to have hedged trades. 

 

AutoGMT_Offset true/false: Change to false only if you want to use the  

ManualGMT_Offset in your live trading. In this case, please ensure that you have used the correct 

ManualGMT_Offset for your broker. 

 

ManualGMT_Offset: For this parameter you have to set the winter GMT offset of your broker. This parameter 

is very important in case that you have disabled the AutoGMT_Offset=false and when you backtest the 

Volatility Factor EA. If you set wrong value, then you may get unexpected results.  

 

DST_Usage true/false: If your broker shifts the GMT_Offset with +1 hour in the end of March and change it 
back in the end of October, you should set DST_Usage=true for live trading. This is important for the correct 
functioning of the second trading system (Signal_2).  
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BetterPricePips: Minimal distance, in standard (4 digits) pips, between the initial position and the additional 

positions. In the Volatility Factor settings, this value is zero, which means that the default value of 

BetterPricePips is used.  

 

MaxNegAdds: Shows how many additional positions can be added to the initial position when the price is 
moving in a negative direction.  
 
ForceProfit: The average profit for all open SELL or BUY positions, in standard (4 digits) pips, on which 
Volatility Factor will close all positions by market. In the Volatility Factor settings, this value is zero, which 
means that the default value of ForceProfit is used. You have information for the default ForceProfit and 
ForceLoss values in the Volatility Factor HUD (Heads-up Display). 
 
ForceLoss: The average loss for all open SELL or BUY positions, in standard (4 digits) pips, on which Volatility 
Factor will close all positions by market. In the Volatility Factor settings, this value is zero, which means that 
the default value of ForceProfit is used. You have information for the default ForceProfit and ForceLoss values 
in the Volatility Factor HUD (Heads-up Display).  
 
FixedTakeProfit: A fixed TakeProfit level in standard (4 digits) pips, which is identical for all open SELL or BUY 
positions. In the Volatility Factor settings, this value is zero, which means that FixedTakeProfit is not used. 
This allows your exit levels to be hidden from the broker. You can use FixedTakeProfit by your estimation.  
 
FixedStopLoss: A fixed stoploss level, which is identical for all open SELL or BUY positions. In the Volatility 
Factor settings, this value is zero, which means that FixedStopLoss is not used. In this way, your exit levels will 
be hidden from the broker. Use your judgment to decide when to use FixedStopLoss. 
 
CloseOnlyOnProfit true/false: when this mode is enabled, positions close to system signals only, when they 

are in profit (MinProfitPips), or where stoploss may be reached. If CloseOnlyOnProfit= false /default/, 

positions close to system logic even it is on a loss. 

 
MinProfitPips: The minimum average profit in standard (4 digits) pips, on which Volatility Factor will close all 
positions by system exit signal, when CloseOnlyOnProfit is true. 
 
UseCustomPair true/false: if you wish to use Volatility Factor EA on an unsupported currency pair, change 
UseCustomPair=true. This way you will be able to test and use the robot on other currency pairs than the 
default supported (GBPUSD, EURUSD, USDJPY and USDCHF).  
 
UseSettingsFrom: if you wish to use Volatility Factor EA on an unsupported currency pair, with this input 
parameter you can choose, which supported settings you wish to use. At the moment you have four possible 
choices – GBPUSD, EURUSD, USDJPY and USDCHF. It is not necessary to change this parameter if you use 
some of the supported currency pairs. This parameter works only when "UseCustomPair=true". 
 
 

Risk management is fundamentally important in attaining optimum forex trading results. It pays to think 

carefully before deciding what percentage of your account to expose to risk in each individual transaction. 
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RecoveryMode true/false: When RecoveryMode is activated, an algorithm effectively compensates current 
drawdown through smooth increases of trading volumes. This mode is active only when AutoMM is greater 
than zero (AutoMM > 0). Before activating RecoveryMode, please bear in mind that it can significantly 
increase risk to your account. For this reason, RecoveryMode ought to be used at low values of the 
AutoMM parameter: AutoMM =1 or lower. 
 
FixedLots: The extent of the fixed trading volume. If you use AutoMM>0, the value of the FixedLots 
parameter does not matter. 
 
AutoMM: Automatic risk management activates at values greater than zero: 

 Example 1: At AutoMM = 1, Volatility Factor opens positions equal to 0.1 lots 
(10,000) given an account extent of 10,000. This places 1% of the account extent at risk per individual 
transaction at a loss of 100 pips. 

 Example 2: At AutoMM = 2, Volatility Factor opens positions equal to 0.2 lot 
(20,000) given an account extent of 10,000. This places 2% of the account extent at risk per individual 
transaction at a loss of 100 pips. 

 
AutoMM_Max: The maximum permitted risk expressed as a percentage of the account per individual 
transaction, calculated on the basis of a 100-pip loss. This parameter concerns the RecoveryMode only. 
 
We can conditionally define the AutoMM with the next examples: 
 
AutoMM=1.5 and lower can be considered reasonably low risk. If using this level of risk with Volatility Factor, 
your account will survive in any circumstances. You will have enough margin to recover even after very bad 
drawdown periods. At the same time, you will have enough potential to realize profits and double your 
account every year. We recommend this level or a lower risk level for accounts of significant importance. 
 
AutoMM=1.5 to 3 can be considered reasonably moderate to medium risk. If using this level of risk, you will 
have excellent potential to realize profits and the risk for your account will remain reasonable. In this case, 
you can expect up to 1000% ROI on an annual basis. This is our favorite risk level, and we use exactly this level 
of risk in our public real account. 
 
AutoMM=3 to 5 can be considered relatively medium to high risk. If using this level of risk, the potential for 
profits is greater, but the risk for your account will be significant as well. The drawdowns of the equity could 
look really dramatic. It would be reasonable to use this level of risk only on small accounts at the beginning if 
you want use the advantage of the full risk and profit potential. 
 

 
AutoMM>5 can be considered very high risk. We do not recommend a level of risk greater than AutoMM=5.  
 

Avoid_News true/false - if you wish to use the news filter function, you should set  
Avoid_News=true 

Include_Medium_News true/false - if you wish to avoid the medium impact news too, you should set 
Include_Medium_News=true  
 
Wait_Before_News - the number of minutes before the news event, during which trading will be switched off  
 
Wait_After_News - the number of minutes after the news event, during which trading will be switched off 
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Time Management Settings 

These settings have been specially developed to help traders avoid certain hour periods during the trading 

week when the Forex market behaves more unpredictable.  

 

NoAddsAlso true/false – when this parameter is enabled, the EA will not open any additional positions during 

the forbidden trading hours. 

MondayTrading true/false – enables trading on Monday. 

MondayHoursForbidden – sets forbidden trading hours for Monday (applies only when MondayTrading is 

enabled). You can set several values between 0 and 23 separated with commas. For example, if you set 

MondayHoursForbidden=9,10,11 the EA will not trade from 9:00 till 11:59. The hour values for this parameter 

are related to your broker’s server time (the Market Watch)! 

TuesdayTrading true/false – enables trading on Tuesday. 

TuesdayHoursForbidden – same as MondayHoursForbidden with the difference that you set forbidden hours 

for Tuesday. 

WednesdayTrading true/false – enables trading on Wednesday. 

WednesdayHoursForbidden – same as MondayHoursForbidden with the difference that you set forbidden 

hours for Wednesday. 

ThursdayTrading true/false – enables trading on Thursday. 

ThursdayHoursForbidden – same as MondayHoursForbidden with the difference that you set forbidden 

hours for Thursday. 

FridayTrading true/false – enables trading on Friday. 

FridayHoursForbidden – same as MondayHoursForbidden with the difference that you set forbidden hours 

for Friday. 

SaturdayTrading and SundayTrading true/false – enables trading during Saturday and Sunday respectively. 

Due to big GMT offset, some brokers trade during weekends and for that reason we added these parameters 

as well. 
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VOLATILITY FACTOR 2.0 PRO  

BROKER SPY MODULE 
An insider look to the Broker behavior 

 

 
The BROKER SPY MODULE compares the initial entry/exit price ordered from the robot, with the actual broker 

execution price. The difference between the ordered price and the broker execution price is the actual 

slippage.  

If the broker is a correct one (and you are not trading news, spikes or other extreme scalping techniques) the 

slippage could be either positive, or negative. In long term the average slippage should be close to zero.  

Unfortunately some brokers are literally stealing from their clients with tendentious negative slippage 

without any objective market reason. This is why we’ve developed the BROKER SPY MODULE – to provide to 

our users this extremely important information - an inside look to the broker’s behavior.  



 

 
 

- 19 - 

The BROKER SPY MODULE aggregates the whole important information of all trades executed from the robot 

since it is started. All statistics is written on an external file, so even if you restart the robot multiple times the 

statistics will not be lost.  

If you change the magic number of the robot, the robot will create a new file and the statistic will start from 

that moment. All statistics files from different magic number initializations will be kept with the used magic 

number in the name of the file. If you want to continue the statistics on some particular file you just need to 

initialize the robot with the same magic number as is in the file name. The BROKER SPY MODULE statistics 

files are located in the MT4 Data Folder->MQL 4->Files.  

The BROKER SPY MODULE also provides important information about the average order execution delay. The 

order execution delay could be initiated from the broker in low liquidity conditions, or other objective reasons. 

Unfortunately in some cases some brokers could use this tendentiously to steal their clients. In other cases 

the orders delay could be caused by poor, or busy internet connection. However in all possible scenarios this 

is a very important information to know. It could be considered as normal if your order delay is below 1000 

ms (1s) in normal market conditions, unless you do not get a tendentiously negative slippage. 

In addition the BROKER SPY MODULE provides statistics for the average spread for all moments in which the 

robot initiate a trade signal. 

 

Here is what exactly the BROKER SPY MODULE (BSM) statistics show: 

The values in the brackets represent the extracted from the BSM history file data, from all previews 

initializations of the robot. The values outside the brackets represent the statistics since the last initialization 

of the robot. 

First Trade – the date and time of the first trade from the statistics. 

Last Trade – the date and time of the last trade from the statistics. 

Total Errors – the total number of recorded errors for all type of orders 

Stop/Limit Orders - the total number of successfully placed pending orders 

Stop/Limit Deals - the total number of successfully activated pending orders 

Market Trades - the total number of successfully executed market orders 

Total Entry Slippage – the total slippage from all market and all activated pending orders in standard 4 digit 

pips. 

Average Slippage – the average slippage from all market and all activated pending orders in standard 4 digit 

pips. 

Average Speed – the average time delay for accepting of all type of orders in milliseconds (ms) 

Exit Signal Trades – the total number of successfully executed exit market orders 
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Total Exit Slippage - the total slippage from all exit market orders in standard 4 digit pips. 

Average Slippage – the average slippage from all exit market orders in standard 4 digit pips. 

Average Speed - the average time delay for accepting of all exit market orders in milliseconds (ms) 

Average Spread – average spread for all trading signals generated from the robot in standard 4 digit pips. 

Last Signal Spread – the spread for the last trading signal generated from the robot 

High Spread Count – the total number of cases in which the trade is canceled due to high spread, considering 

the MaxSPREAD setting. 

 

BROKER SPY MODULE 
 SETTINGS 

 
BSM_Alerts true/false: use True, if you want to activate the Broker Spy Module alerts.      

BSM_Alert_Open_Delay: the maximum allowed delay in milliseconds (ms) for opening new trades, above 

which the BSM will display an alert.               

BSM_Alert_Open_Slippage: the maximum allowed slippage (in standard 4 digit pips) for opening new trades, 

above which the BSM will display an alert.                   

BSM_Alert_StopLimit_Delay:  the maximum allowed delay in milliseconds (ms) for accepting pending 

(Stop/Limit) orders, above which the BSM will display an alert.              

BSM_Alert_StopLimit_Slippage: the maximum allowed slippage (in standard 4 digit pips) for activating 

pending (Stop/Limit) orders, above which the BSM will display an alert.   

BSM_Alert_Close_Delay:  the maximum allowed delay in milliseconds (ms) for closing trades, above which 

the BSM will display an alert.             .              

BSM_Alert_Close_Slippage: the maximum allowed slippage (in standard 4 digit pips) for closing trades, above 

which the BSM will display an alert.            
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RISK MANAGEMENT HINTS 

Risk management is of fundamental importance in attaining optimum forex trading results. It pays to think 

carefully before deciding what percentage of your account to expose to risk in each individual transaction. 

If your account is significant in extent and importance and if you do not wish to take unnecessary risk, then 

you should settle for AutoMM values between 1 and 5 percent risk per individual transaction. In such case, 

you may expect a return on investment in the order of 10 to 100 percent on an annual basis. 

If your account is not significant in extent or importance, and if you can afford to assume significant risk, then 

you may select AutoMM values between 10 and 20 percent per individual transaction. In such case, you may 

expect a return on investment in the order of 200 and 1000 percent on an annual basis. Bear in mind, however, 

that the level of risk assumed means that the chance of losing the entire account increases.  

In reality, perhaps the most widely assumed risk per individual transaction is 5 percent (AutoMM=5), and for a 

good reason. Assuming 5 percent risk and applying a good trading strategy, your chances of steady long-term 

profit are significant, while the risk of losing the entire account is minimised.  

For example, if you have a USD 10,000 account, then: 
 
- If AutoMM=0, the EA will trade with volume = parameter FixedLots (defaults        FixedLots=0.1) 
- If AutoMM=2 (2 percent risk) the EA will open 0.2 lot positions (20,000) 
- If AutoMM=5 (5 percent risk) the EA will open 0.5 lot positions (50,000) 
- If AutoMM=10 (10 percent risk) the EA will open 1.0 lot positions (100,000) 
 
 

 

HOW TO BACKTEST 

VOLATILITY FACTOR 2.0 PRO 
 

Please, do not forget to activate your Demo, or Real-Money Account, even if you only wish to backtest 

Volatility Factor 2.0 Pro!  

If you wish to back-test Volatility Factor 2.0 Pro, first you should download history from the MetaTrader 

history center: click Tools -> History Center, or press the "F2" key of the keyboard.  In the list, find the 

currency pair that you wish to back-test and double click to expand it. Click "1 Minute (M1)" and then click 

"Download". When the download process is finished, double click on "5 Minutes (M5)” and "15 Minutes 

(M15)" to convert the M1 data. Close the "History Center" window. 
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To open the "Strategy Tester" window click the "Strategy Tester" button of the MetaTrader menu, or press 

"Ctrl+R" on the keyboard. In the "Strategy Tester" window chose " Volatility Factor 2.0 Pro ", chose one of 

the supported currency pairs, chose M15 timeframe, chose the method "Every tick ...", as shown below. Click 

"Start" to start the back-test.  
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The back-test by "Every tick" is the most precise, but it is very slow. If you wish to save time you can run the 

back-test on M1 timeframe by "Open price only ..." method and this will be correct too.  

Important notice: If you make a back-test and at the same time you have Volatility Factor 2.0 Pro attached 

on the chart in live trading mode, this can overload your MetaTrader4 terminal and can be a cause for a 

MataTrader 4 terminal crash. Do not make back-tests on the same MataTrader 4 terminal, which you use for 

live trading! 

 
 

We strongly recommend that you operate a demo account before trading with real money. This will help 

you become familiar with the way Volatility Factor 2.0 Pro operates before you commit genuine funds to a 

real money account. 
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Terms of Use and Risk Disclosure 
 
U.S. GOVERNMENT REQUIRED DISCLAIMER 
FOREX trading has large potential rewards, but also large potential risk. You must be aware of the risks and be willing to 
accept them in order to invest in the FOREX markets. Don’t trade with money you can’t afford to lose. This is neither a 
solicitation nor an offer to Buy/Sell currencies, futures or options. No representation is being made that any account will 
or is likely to achieve profits or losses similar to those discussed on this web site. 
The past performance of any trading system or methodology is not necessarily indicative of future results. 
Trading foreign exchange on margin carries a high level of risk and is not suitable for all investors. The high degree of 
leverage can work against you. As with all investments, you should not invest money that you cannot afford to lose. 
Before deciding to invest in foreign exchange, you must carefully consider your investment objectives, level of 
experience, and risk appetite. Additionally, you must be aware of all the risks associated with foreign exchange trading 
and seek advice from an independent financial advisor. Past results are not necessarily indicative of future success. 
 
CFTC RULE 4.41 – HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN LIMITATIONS. UNLIKE AN 
ACTUAL PERFORMANCE RECORD, SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE TRADES 
HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER COMPENSATED FOR THE IMPACT, IF ANY, OF 
CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE ALSO 
SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO REPRESENTATION IS BEING 
MADE THAT ANY ACCOUNT WILL OR IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN. 
 
By using Volatility Factor 2.0 Pro, you acknowledge that you are familiar with these risks and that you are solely 

responsible for the outcomes of your decisions. We accept no liability whatsoever for any direct or consequential loss 

arising from the use of this product. It's to be noted carefully in this respect, that past results are not necessarily 

indicative of future performance. 

 
Your purchase Volatility Factor 2.0 Pro serves as your acknowledgement and representation that you have read and 

understand these TERMS OF USE and that you agree to be bound by such TERMS OF USE ("License Agreement"). 

Copyright Information 
 
REPRODUCTION AND OR TRANSLATION OF ANY PART OF THIS WORK BY ANY MEANS ELECTRONIC OR MECHANICAL 
INCLUDING PHOTOCOPYING BEYOND THAT PERMITTED BY COPYRIGHT LAW WITHOUT THE PRIOR WRITTEN PERMISSION 
OF THE PUBLISHER IS UNLAWFUL. 
 
Copyright © 2017 – Volatility Factor 2.0 Pro, www.volatilityfactor2.com, 
www.volatilityfactor2.com - All Rights Reserved 
  
Author: Volatility Factor EA Team 
Website: www.volatilityfactor2.com 
 
 


